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Copyright 

The CHASE computer program is Copyright Ò 1996-2011 Health And Safety Technology And Management Ltd 
(HASTAM).  It is illegal to make copies of the program, other than for legitimate back-up purposes, without 
written permission from HASTAM. 

Crystal Reportsá is a product of Crystal Decisions. 

Polar Spelling Component is a product of Polar. 

Graphics Server is a product of Graphics Server Technologies. 

 

Trademarks 

All product names mentioned in this User Guide are acknowledged to be the marks of the companies producing 
them. 

 

Software Support 

HASTAM provides a telephone support service for its software.  This operates from 9.00am to 5.00pm UK time, 
Monday to Friday with the exception of public holidays and the period 27 - 31 December inclusive. 

If calling for support, please try to have the following information to hand. 

 The serial number and version of the CHASE ǇǊƻƎǊŀƳ όƭƻƻƪ ƛƴ IŜƭǇμ!ōƻǳǘΧύ 
 The nature of the problem, including any error messages. 
 The version of Windows being used. 
 

Please try to be at the computer when you call, so that one of the support team can talk you step by step 
through the difficulty, or if you fax or e-mail us, please include as much detail as possible about your problem, 
including the version number of the CHASE program you are using.  This can be found in the About CHASE option 
in the Help menu. 

The telephone number for support is 0844 561 0434.  Please ask for CHASE support.  Alternatively you can e-
mail support@hastam.co.uk with details of the problem.  We also have a World Wide Web site which includes a 
CHASE support page listing a number of common difficulties together with their solutions.  Go to 

www.hastam.co.uk to find our Support Page. 

 

Health And Safety Technology And Management Ltd 
Suite 729 
10 Sovereign Court 
8 Graham Street 
Birmingham  
B1 3JR 
United Kingdom 
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Section 1  CHASE Introduction 

Purpose of this User Guide 
¢ƘŜ ōǳƭƪ ƻŦ ǘƘŜ ǳǎŜǊΩǎ ƎǳƛŘŜ ǘƻ CHASE is built into the program itself, in the Help files.  These can be accessed by 
choosing Help from the CHASE main menu or by pressing the F1 key.  This User Guide is designed to get you to the 
stage where CHASE is running on your computer and to show you the main features of the system.  The first 
section gives you an overview of CHASE and how it is used in an organisation; the other sections concentrate on 
guiding a new user into CHASE for the first time and show what kind of displays to expect on screen.  If you are 
already familiar with the CHASE concepts, perhaps in one of its earlier versions, you can go straight to Section 2 
which introduces the program itself. 

CHASE Overview 
CHASE can be used to manage the results from audits, self-assessments, active monitoring, behavioural safety 
inǘŜǊǾƛŜǿǎΣ ƛƴǎǇŜŎǘƛƻƴǎ ŜǘŎΦ  ¢ƘŜ ǘŜǊƳ άŜǾŀƭǳŀǘƛƻƴέ ƛǎ ǳǎŜŘ ǘƻ ŜƴŎƻƳǇŀǎǎ ŀƭƭ ƻŦ ǘƘŜǎŜ ŀŎǘƛǾƛǘƛŜǎΦ 

Data from completed evaluations can be presented in tabular format, graphical format or as report.  Data from 
different evaluations can be compared or combined into a single set of summary scores.  Facilities are provided 
to export data to other packages, such as spreadsheets or graphics packages. 

Using the CHASE program greatly increases the amount of information that can be extracted from evaluations as 
it allows rapid processing and comparison of scores over time or between locations and tracking of 
recommendations. 

Terminology used in CHASE 
CHASE uses the terms Module, Area, Evaluation and Audit throughout so these will be introduced now.   

A Module is the set of questions and guidance used to form the basis of the evaluation. 

An Area is the area of responsibility within the organisation which is going to be monitored or audited using 
CHASE.   

An Evaluation is the set of answers, notes and recommendations made by the user when answering the 
questions in the module with respect to the area on a particular date.  Evaluation encompasses audit, 
assessment, inspection, monitoring and other similar terms. 

An Audit is an evaluation that is carried out by an independent person or body.  CHASE permits a manager to 
carry out a self-evaluation and then a second person to independently verify the answers to produce an audit. 

Before a module can be used to carry out an evaluation it has to be associated with an area.  This can be done on 
a one-off basis or an Allocation can be created which can be used to schedule repeated evaluations. 

CHASE Management Principles 
CHASE is designed to help management and specialists satisfy the requirements of a standard management 
model, which is shown in a simplified form below. 

Plans are normally sets of statements, but they can also be expressed in the form of questions as in this simple 
example. 

The statement 

ά!ƭƭ ƳŀƴŀƎŜǊǎ ǿƛƭƭ ƘŀǾŜ ŀ ²ǊƛǘǘŜƴ IŜŀƭǘƘ ŀƴŘ {ŀŦŜǘȅ tƻƭƛŎȅ ǿƘƛŎƘ ǘƘŜȅ ǿƛƭƭ ǊŜǾƛŜǿ annually and update as 
ƴŜŎŜǎǎŀǊȅέ 

PLAN 

IMPLEMENT 

MONITOR 

AUDIT 
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could be expressed in the form of the following questions addressed to each manager. 

ά5ƻ ȅƻǳ ƘŀǾŜ ŀ ²ǊƛǘǘŜƴ IŜŀƭǘƘ ŀƴŘ {ŀŦŜǘȅ tƻƭƛŎȅΚέ 
άIŀǾŜ ȅƻǳ ǊŜǾƛŜǿŜŘ ȅƻǳǊ IŜŀƭǘƘ ŀƴŘ {ŀŦŜǘȅ tƻƭƛŎȅ ƛƴ ǘƘŜ ƭŀǎǘ ǘǿŜƭǾŜ ƳƻƴǘƘǎΚέ 
άLǎ ȅƻǳǊ IŜŀƭǘƘ ŀƴŘ {ŀŦŜǘȅ tƻƭƛŎȅ ǳǇ ǘƻ ŘŀǘŜΚέ 

A complete plan is expressed in the form of a structured set of questions, which called a module in CHASE 
terminology. 

You can write your own modules or purchase ready written ones from HASTAM.  Modules are available for a 
range of topics including health and safety management (CHASE SMS and CHASE SMi in HSG65 or OHSAS 18001 
versions) and environmental management (CHASE EME).  They can be used without modification or, using the 
optional CHASE editor, tailored to your own requirements by adding and deleting questions or amending them to 
ǎǳƛǘ ȅƻǳǊ ƻǿƴ ƻǊƎŀƴƛǎŀǘƛƻƴΦ  /I!{9 ƛǎ ŀƭǎƻ ǿŜƭƭ ǎǳƛǘŜŘ ǘƻ ǊŜŎƻǊŘƛƴƎ ƛƴŦƻǊƳŀǘƛƻƴ ŀǎ ǇŀǊǘ ƻŦ I!{¢!aΩǎ ōŜƘŀǾƛƻǳǊŀƭ 
safety programme, SAM.  Details of SAM can be found at www.hastam.co.uk and follow the links to SAM 

Since questions may refer to topics which are not familiar to those people answering them, CHASE can show 
guidance to each question.  For example, in the simple questions above it may reasonably be expected that all 
ƳŀƴŀƎŜǊǎ ǿƛƭƭ ǳƴŘŜǊǎǘŀƴŘ άƭŀǎǘ ǘǿŜƭǾŜ ƳƻƴǘƘǎέΣ ōǳǘ ǘƘŜǊŜ Ƴŀȅ ōŜ ǘƘƻǎŜ ǿƘƻ ŀǊŜ ƴƻǘ ŎƭŜŀǊ ǿƘŀǘ ǿƛƭƭ ōŜ ǊŜǉǳƛǊŜŘ 
in a Health and Safety Policy.  The Health and Safety Policy question could therefore contain information on the 
required contents of such a policy and information on where to obtain help in preparing one. 

Using the blueprint provided by the module questions and guidance, managers can implement appropriate 
actions.  They can also use the module questions to check periodically that things are going as planned.  For 
example, managers could answer all the questions on a quarterly basis to monitor that things they want done, 
ŀǊŜ ƛƴ ŦŀŎǘΣ ōŜƛƴƎ ŘƻƴŜΦ  ²ƘŜǊŜ ǘƘŜȅ ŦƛƴŘ ǘƘŀǘ ǘƘŜȅ ƘŀǾŜ ǘƻ ŀƴǎǿŜǊ άbƻέ ǘƻ ǇŀǊǘƛŎǳƭŀǊ ǉǳŜǎǘƛƻƴǎΣ ǘƘŜȅ Ŏŀƴ then 
take appropriate remedial action. 

In addition, they can pass a copy of their monitoring results to the senior managers, or the specialists who issued 
the module, so that they too can keep track of the implementation of their plan.  The senior managers and 
ǎǇŜŎƛŀƭƛǎǘǎ Ŏŀƴ ǘƘŜƴ ŀƳŜƴŘ ǘƘŜƛǊ ǇƭŀƴǎΣ ŀƴŘ ŀƭǘŜǊ ǘƘŜ ƳƻŘǳƭŜΩǎ ǉǳŜǎǘƛƻƴǎ ŀƴŘ ƎǳƛŘŀƴŎŜ ŀǎ ƴŜŎŜǎǎŀǊȅΦ 

The last element is audit.  In the CHASE terminology, audit is used to mean a check on all aspects of planning, 
implementing and monitoring, by persons independent of the line management being audited.  Audit is 
recognised as an important aspect of modern management systems.  CHASE modules can be used for audit 
purposes if the questions and guidance in the modules reflect the standards to which the organisation is 
operating, and the questions are answered (or verified) by independent, competent auditors.  Separate guidance 
(Verification guidance) is also provided in a number of the HASTAM modules to assist auditors. 

CHASE can therefore be used by a number of different categories of people, for a variety of purposes.  The table 
below contains a summary of these people and purposes. 

 USERS  

Senior managers and specialists Managers Auditors 

Create modules embodying their 
plans in the form of questions 
with guidance on what is 
required. 

Use questions and guidance as a 
blueprint for what they have to 
implement. 

Use questions and guidance as a 
statement of the standards to 
which the organisation is 
operating. 

 Ask questions periodically about 
the area for which they are 
responsible (Monitoring).  Take 
corrective action as necessary. 

Ask questions and collect evidence 
to support the answers.  Suggest 
remedial actions as appropriate. 
(Auditing) 

Examine monitoring and audit 
results and take remedial action 
as necessary. 

Feed back results to senior 
managers and specialists. 

Feed back results to senior 
managers and specialists and 
managers responsible for areas. 

Setting up CHASE Modules 

Preparing Questions and Guidance 

The usefulness of CHASE will depend to a large extent on the effectiveness of the questions and guidance 
contained in the modules.  If these do not reflect accurately what is required, the monitoring and audit results 

http://www.hastam.co.uk/
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obtained will be of limited value.  For this reason it is important to put thought and care into the setting up of 
modules.  If you do not have the optional Editor on your copy of CHASE you will need ready written modules, 
either from HASTAM or a third party.  HASTAM has a range of modules for Health and Safety and Environmental 
Management. 

Preparing Modules for use by Managers 

Typically, a CHASE ƳƻŘǳƭŜ ǿƛƭƭ ōŜ ǳǎŜŘ ōȅ ŀ ƴǳƳōŜǊ ƻŦ ƳŀƴŀƎŜǊǎΦ  CƻǊ ŜȄŀƳǇƭŜΣ I!{¢!aΩǎ /I!{9 SMi health and 
safety module would be applicable to all managers.  In order to conduct monitoring or an audit, a module (the 
questions) has to be linked to an area of responsibility.  An area, so far as CHASE is concerned, is simply a name, 
ŦƻǊ ŜȄŀƳǇƭŜΣ άtǊƻŘǳŎǘƛƻƴ ŘŜǇŀǊǘƳŜƴǘέ ƻǊ άDƭŀǎƎƻǿ ǎƛǘŜέΦ  9ŀŎƘ ŀǊŜŀ Ŏŀƴ ōŜ ƭƛƴƪŜŘ ǘƻ ƻƴŜ ƻǊ ƳƻǊŜ ƳƻŘǳƭŜǎΦ  

CHASE allows virtually unlimited creation of audits or evaluations for each area-module combination.  The audits 
or evaluations can be carried out on one central computer with managers completing paper audits, or they can 
have their own copies of CHASE, complete their own audit or evaluation on their own computer, possibly a 
portable, and send the data to a central co-ordinator on disk or via a network. 

Use of Modules by Managers 

Data Input 

When using CHASE for monitoring purposes, the main data input task is to answer the questions contained in the 
module, following, where necessary, the guidance given.  However, there are two optional additional input 
facilities available for each question. 

Notes.  User may make notes about their answers, for example recording details of why a particular answers was 
given..  These notes appear on the screen for the question to which they refer. 

Recommendations.  It may be the case that a user wishes to record or recommend remedial action.  CHASE 
Recommendations include priorities and dates and CHASE keeps track of them so that users can, for example, 
print a list of outstanding recommendations.  The creation of Action Plans in this way can be very effective in 
assisting managers to plan how they are going to achieve continuous improvement in their performance. 

Analysis 

CHASE provides a wide range of data analysis options.  The principal uses of data analysis are as follows. 

Trend analysis.  By comparing the results from the latest monitoring with previous ones, managers can see 
whether their performance with respect to the issues covered by the module, is improving or deteriorating. 

Identifying strengths and weaknesses.  By looking at the answers to groups of questions within a module and 
comparing the results from different groups, managers can identify areas of strength and weaknesses. 

Use of CHASE Results across an Organisation 
In addition to the use of CHASE analysis by individual managers as previously described, those with access to 
CHASE results from more than one area can also use CHASE to carry out the following additional types of analysis. 

Comparison of areas.  The results from one area can be compared with the results from one or more other areas.  
This allows the identification of relative strengths and weaknesses from one area to another. 

Combining results from one or more areas.  Most organisations are arranged in hierarchies with, for example, a 
number of areas making up a Division and a number of Divisions making up a Group.  CHASE allows results from 
any number of areas to be combined to give a composite score.  Where, for example, areas are combined 
because they form a Division, CHASE can produce a composite score automatically, reflecting the performance of 
the Division as a whole.  Divisional composite scores can then be combined to give a score for the whole 
organisation.  This process of combining scores can be repeated for as many organisational levels as are required. 

Comparing combined scores.  The combined scores described above can be compared with each other when 
required.  For example, if two or more Divisional composite scores have been prepared, these can be compared 
to identify Division wide strengths and weaknesses and trends in Divisional performance. 

Organisation of Modules, Areas and Evaluations 

A module can be small with perhaps only 20 or 30 questions or large with several hundred questions, depending 
on the purpose, depth and extent of the desired evaluation.  A number of modules are available from HASTAM, 
as listed in the previous section, to evaluate a number of different aspects of Health, Safety and Environmental 
management.  In addition modules can be created using the optional Module Editor, or existing modules 
modified so that the questions and guidance match more closely the requirements of the organisation. 
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An area is an area of responsibility that will be evaluated.  It is usually one physical location or site but could be 
several locations, if small and the responsibility of one person.  The management structure of the organisation 
will help to determine the precise nature of the areas.  Areas can be grouped together as sub-areas of another 
area for easier management of large numbers of them. 

An evaluation is created by linking a module (ie the questions) to an area and then answering the questions on a 
particular date. 

If required, the module and area can be linked together in an allocation.  When the allocation is made you also 
determine how often the area should be evaluated using the module. This is convenient for evaluations that will 
be repeated on a regular basis. 

The evaluation records hold the answers to the questions, notes that were made when the questions were 
answered and any recommendations made when the evaluation was completed. 

The scores from several evaluations can be combined into a summary.  This allows an organisation with a number 
of regions or departments to combine evaluations at different levels within the organisational structure.  
Ultimately this provides an overall score for the whole organisation, as summaries may themselves be 
summarised. 

Finally, a specialised type of evaluation can be created called a target.  A target is a copy of a completed 
evaluation where a manager goes through the questions identifying (targeting) questions where he or she 
believes that a No answer will become a Yes answer by the time of the next evaluation.  This can generate a 
target score which can be subsequently compared against the actual score, and a list of targeted questions that 
can form an action plan for the manager. 

 

This completes the introduction to CHASE principles.  The remainder of this User Guide is concerned with the use 
of the program itself. 

Evaluation 

Module 

Date 

Area Allocation 
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Section 2  Installing CHASE 

System Requirements 
CHASE requires Microsoft Windows 98, NT 4.0 (Service Pack 6), Me, 2000, XP or later.  For good performance use 
a PC with a 300MHz or faster Pentium, 128MB or more RAM and an 800 x 600 or better display.  

Installation 
CHASE is supplied on an individually created CD-R disk, which is not as robust as a mass-produced CD-ROM.  
Please handle it carefully and do not leave it in direct sunlight. 

Close down all applications before installing CHASE.  Place the CHASE disk in your CD-ROM drive.  If your drive has 
Autorun enabled, the setup program will start automatically after about 15 seconds.  If nothing happens, click on 
Start and select Runé  Enter d:\setup.exe where 'd' is the letter corresponding to your CD-ROM drive. 

The Setup program 

CHASE is installed by an InstallShield® program which uses the Windows Installer program, introduced by 
Microsoft with Windows 2000.  If your computer does not have this program installed already, this is set up first 
and your computer re-started before CHASE itself is installed. 

Most of the questions posed during the installation 
should be self-explanatory.  However, the following 
may require further explanation. 

The Destination Folder is the location of the CHASE 
program files.  This is usually within the Program Files 
folder on your C:\ drive.  If you alter this, please 
make a note of the new folder. 

The Database Folder is, by default, located in the 
ǳǎŜǊΩǎ My Documents folder.  However, you may prefer 
to locate the CHASE data files elsewhere, for example on 
a network server.  This could be desirable for two 
reasons. 

1. The C\: drive may not be backed up regularly while most 
network servers will be.  In the event of a computer or 
disk failure data will not be lost.   

2. If the data is on a shared network drive other users will 
be able access it. 

(Administrators please note that if you are installing on 
behalf of a user you should take care to ensure this is set to a 
ŦƻƭŘŜǊ ǘƘŜȅ ǿƛƭƭ ƘŀǾŜ ŀŎŎŜǎǎ ǘƻΣ ŀƴŘ ƴƻǘ ȅƻǳǊ ƻǿƴ άaȅ 
5ƻŎǳƳŜƴǘǎέΦύ  ¢ƻ ŎƘŀƴƎŜ ǘƘŜ 5ŀǘŀōŀǎŜ CƻƭŘŜǊΣ ǎŜƭŜŎǘ Changeé and either select the folder, or enter its path 
directly, as shown in this example. 

Mapped network drives will appear in the drop-down list.  
However, if the mapping is not permanent, it is better to use the 
universal naming convention as shown here as drive letters 
assigned by the mapping could change.  The files placed in this 
folder are CHASE.MDB, CHASE.MDW and CHASE.CFG together with 
the Crystal Reports files (if these are installed ς see below). 

You will also need to select the set up type required. 

In the vast majority of cases, Typical will be suitable.  This installs 
the CHASE program files, the empty data files, Crystal Reports and 
the documentation. 

If you are setting up additional networked workstations or have specific requirements, select Custom.  This 
option allows you to select which components you want to install. 
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The custom options are shown here.  Click on the drop-
down buttons on each of the features for the installation 
options. 

To install a feature, select either of the top options.  To 
leave out a feature select the last option. 

We do not recommend use of the "Install when required" 
option. 

Application Files includes the CHASE program and its Help files, Documentation includes this document and 
technical specifications in Microsoft Word and PDF formats, Data files are the empty database files and Windows 
System Files are additional files necessary for the CHASE to work which are installed in the Windows/System (Or 
Winnt/System32) directory.  The Crystal Reports option installs the Crystal Reports files and reports and Spelling 
Checker installs the Polar SpellChecker Component. 

Once all the settings arŜ ŎƻǊǊŜŎǘΣ ǿƻǊƪ ǘƘǊƻǳƎƘ ǘƘŜ ǎŎǊŜŜƴǎ ǳƴǘƛƭ ȅƻǳ ƎŜǘ ǘƻ ΨFinishõ.  The installation will normally 
ŀƭƭƻǿ ȅƻǳ ǘƻ ǾƛŜǿ ŀ άwŜŀŘ ƳŜέ ŦƛƭŜ ǿƛǘƘ ǘƘŜ ƭŀǘŜǎǘ ƛƴŦƻǊƳŀǘƛƻƴΦ  IƻǿŜǾŜǊΣ ŘŜǇŜƴŘƛƴƎ ƻƴ ǿƘŀǘ ƻǘƘŜǊ ǎƻŦǘǿŀǊŜ ƛǎ 
already installed on your computer, you may be told to re-start your computer first. 

A program group called CHASE is created containing a short cut to the CHASE program.  If you have purchased 
HASTAM modules (eg CHASE SMS/SMi or CHASE EME), these are installed from within the CHASE program - leave 
the CD-ROM in the drive until this has been carried out. 

Example Modules are automatically included in the trial version and do not require loading. 

Multiple Copies 
If you have bought two or more copies of CHASE, you must install each copy with its own serial number and 
not use one number several times.  This is because, when transferring records between two CHASE systems, 
errors will occur if the two copies have been installed from the same set of disks or CD-ROM.  Each copy of CHASE 
is issued with a unique serial number and this is used to identify its own records.   

Backing up data 
You should always ensure you have up to date backup copies of CHASE.MDB, CHASE.MDW and CHASE.CFG. 

Moving CHASE 
If you need to move CHASE from one computer to another, please refer to details of how to do this at the end of 
this User Guide. 

Removing CHASE 
If you need to take CHASE off a computer you should use the Add/Remove programs function in Control Panel.  
The data files above are not removed by the uninstall program and will always have to be deleted manually.  This 
action is deliberate to reduce the risk of accidentally deleting all the CHASE data. 

If you have Problemsé 
The HASTAM help line is available Monday to Friday, 9am to 5pm.  Call 01621 854111 for assistance, preferably 
while you are at the computer screen, and we will talk you through any difficulties.  You may also find it useful to 
consult our website (www.hastam.co.uk) where there is a CHASE support page. 
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Section 3  Using CHASE 

Starting CHASE 
The Setup program places a CHASE icon on your desktop.  Double-click on this icon to start CHASE 

Alternatively, if this icon is missing, click on the Start button, select Programs, then the CHASE sub-menu and finally 
Chase. 

If this copy of CHASE is being run for the first time, it will ask you to enter the name of your organisation and the 
program serial number, unless it is a trial copy, in which case the serial number has already been entered.  This 
number is on the CD-ROM.  If you do not have this number, please contact HASTAM.  Please ensure you enter 
ȅƻǳǊ ƻǊƎŀƴƛǎŀǘƛƻƴΩǎ ƴŀƳŜ ŎƻǊǊŜŎǘƭȅ ŀǎ ƛǘ Ŏŀƴƴƻǘ ōŜ ŀƭǘŜǊŜŘ ƭŀǘŜǊ. 

If the program has already been installed you may get a logon screen into which you have 
to enter a User name and/or a 
password, which will have been given 
you by the system administrator. 

If you are the only user and no 
password has been set up you will automatically logon to the 
CHASE database as the Default user. 

This document is intended as an introduction as the bulk of 
the User Guide is in the on-line help.  Select Help from the 
Ƴŀƛƴ ƳŜƴǳ ƻǊ ǇǊŜǎǎ Cм ŦƻǊ ά/ƻƴǘŜȄǘ ǎŜƴǎƛǘƛǾŜέ ƘŜƭǇ ŦƻǊ ǘƘŜ 
ǇŀǊǘ ƻŦ ǘƘŜ ǇǊƻƎǊŀƳ ȅƻǳ ŀǊŜ ǳǎƛƴƎΦ Φ  ¢ƘŜǊŜ ƛǎ ŀƭǎƻ ŀ άvǳƛŎƪ 
DǳƛŘŜέ ǿƘƛŎƘ ƛǎ ŘƛǎǇƭŀȅŜŘ ōȅ ŎƭƛŎƪƛƴƎ ǘƘŜ  button on the 
toolbar. 

Importing Modules 
(This does not apply to the trial system.)  If you have purchased HASTAM modules these can be imported now.  

They are on individual floppy disks or the CD-ROM and are CHASE Export 
files.  Click on the File menu option and choose Import from the file menu.  
A standard Windows Open File dialogue opens, as shown here.  Modules 
are identified by their name - eg the CHASE SMS/SMi modules are in 
CHASE H&S Modules.cxf.  Select the appropriate drive, click on the desired 
module and select Open.  This displays another window showing the 
contents of the file (eg: CHASE SMS HSG65) in the left pane.  Some 
modules have multiple parts and there may be several entries in the left 
pane.  Items to be imported are moved into the right pane, headed Items 

selected for Import by selecting them with the mouse and clicking on the right pointing arrow between the two 
panes.  Click on the Import button to copy the data into the CHASE database - this can take several minutes if 
loading from a floppy disk.  When this is done, close the window to return to the main CHASE program. 

Toolbar 

The toolbar provides short cuts to the main functions and behaves in a similar manner to other Windows 
ǘƻƻƭōŀǊǎΦ  Lǘ ƛǎ ά5ƻŎƪŀōƭŜέ ǿƘƛŎƘ ƳŜŀƴǎ ȅƻǳ ŎŀƴΣ ƛŦ ȅƻǳ ǇǊŜŦŜǊΣ ŘǊŀƎ ƛǘ ŦǊƻƳ ƛǘǎ ŘŜŦŀǳƭǘ Ǉƻǎƛǘƛƻƴ at the top of the 
ǎŎǊŜŜƴ ǘƻ ŀƴȅ ƻǘƘŜǊ ŜŘƎŜ ƻǊ ƘŀǾŜ ƛǘ ŦƭƻŀǘƛƴƎ ǿƛǘƘƛƴ ǘƘŜ /I!{9 ǿƛƴŘƻǿΦ  9ŀŎƘ ōǳǘǘƻƴ Ƙŀǎ ά¢ƻƻƭ¢ƛǇέ ǿƘƛŎƘ ǿƛƭƭ ƎƛǾŜ 
a few words of explanation if you allow the mouse pointer to rest over it for a second or so.  Not all users will see 
all these buttons. 

The menu at the top of the CHASE Window has similar functions to most other Windows programs.  The choices 
available will depend on which CHASE window is being displayed. 

Modules 

Areas 

Allocation
s 

Show Evaluations Recommendations 
Analysis and 

Reports 

Users 

Show Quick 
Guide 

Clipboard 
functions 

Printing 
functions 

These buttons used in 
Analysis and Reports 

Find 

New 
Evaluation 
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Setting up CHASE 
Before you can use CHASE you need to set up a number of items. 

You need to set up areas, which are the parts of your organisation you wish to evaluate using the modules. 

You also need the modules, which are the actual evaluation questions.  These may have been imported already in 
the previous step, or you may have the Editor program installed which allows you to create new modules or 
modify existing ones.  The Editor is described at the end of this section. 

Finally you need to allocate the module(s) to the areas.  These terms are explained more fully later.  If you have 
translated an S-CHASE program, the areas, modules and allocations will be set up for you already and you may 
find it easier to move straight to Answering an Evaluation. 

Remember to use the F1 key for more information as you go through the program.  The other Windows feature 
ǳǎŜŘ ŜȄǘŜƴǎƛǾŜƭȅ ƛǎ ǘƘŜ ά/ƻƴǘŜȄǘ aŜƴǳέΣ ǿƘƛŎƘ ƛǎ ŀ ǎƳŀƭƭ ǇƻǇ-up menu activated by clicking the right mouse 
button.  The contents of this menu depend, as the name suggests, on the position of the mouse pointer.  Try it 
often in the early stages of using CHASE to find out where it is useful. 

Areas (Administrators only) 
Click on the Areas button or select View|Areas from the menu to open the Areas window.  An example of one with a 
number of areas is shown below.  In a new system you will only have only the name of your organisation and you 
must create the others areas underneath it. 

This shows the areas ñtreeò in the left 
panel and the details of the currently 
selected area in the top of the right panel. 

You can edit the name and description 
fields. (The ID is generated by the 
program and cannot be altered.) 

It is also useful to include the name of a 
contact person and their telephone 
number. 

Below these details is a list of the 
modules allocated to the area including 
the interval between evaluations and the 
date the next (or first) is due. 

To edit the list point at it with 

the mouse and click the right 
button to pop up an edit 
menu, shown here, or select 

Allocation from the Edit menu option at 
the top of the screen. 

¸ƻǳ Ŏŀƴ άŘǊŀƎ ŀƴŘ ŘǊƻǇέ ŀǊŜŀǎ ƻƴǘƻ ŜŀŎƘ ƻǘƘŜǊ ǳǎƛƴƎ ǘƘŜ ƳƻǳǎŜΦ  ¢Ƙƛǎ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ōǳƛƭŘ ǳǇ ǘƘŜ ǎǘǊǳŎǘǳǊŜ ŀǎ 
shown.  Any allocations and evaluations already existing will move with the area. 

To create a new area select File|New area.  The new area wiƭƭ ōŜ ŀ άŎƘƛƭŘέ ƻŦ ǘƘŜ currently highlighted area.  For 
example, click on the top name (HASTAM Demonstration in this example) to highlight it, then open the file menu  and 
select New area to create a new main area.  Click on an existing area (eg Depots) before selecting File|New area to 
ŎǊŜŀǘŜ ŀ άǎǳō-ŀǊŜŀέ ǿƛǘƘƛƴ 5ŜǇƻǘǎΦ  ¢ƘŜ ƎǊƻǳǇƛƴƎ ƻŦ ŀǊŜŀǎ ǎƘƻǳƭŘ ƴƻǊƳŀƭƭȅ ƳŀǘŎƘ ǘƘŜ ƻǊƎŀƴƛǎŀǘƛƻƴΩǎ ƳŀƴŀƎŜƳŜƴǘ 
structure. 

The top area (Root) is the organisation name.  This area has a special function within CHASE and is created when 
you run the program for the first time.  Once you have named it, it cannot be altered.  All areas are linked to this. 

Some displays, such as the analysis table, will need to shorten the name because of on-screen space limitations.  
Try to keep names to around 20 characters maximum if possible. 

The program always uses the ID to identify the area record.  If you change the name or correct the spelling, 
evaluations will still remain attached to the same ID number.  If you delete an area, its ID is never re-used.  Areas 
that have evaluations cannot be deleted unless the evaluations are deleted first. 

Areas no longer in use can be hidden from the other CHASE windows by clicking in the Hidden box.  The Depots 
areas in the above example are hidden - note the different icons. 
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Modules (Administrators only) 
Click on the Modules button or select View|Modules to open the modules window, similar to the one below. 

The module names are listed in the left 
panel and the details of the currently 
highlighted module are shown in the 
top of the right panel. 

If you have the Editor you can edit the 

Name and Description fields.  The 

created date field is filled in 
automatically.  (The ID is created by 
the program and cannot be altered.) 

You also decide what category of 
evaluation this module is to be used for 
and whether verification will be 
required. 

Below these details is a list of the 
areas allocated to the module.  It lists 
the area name, the interval between 
evaluations and the date the next (or 
first) is due. 

To edit an allocation, point at it with the 

mouse and click the right button to 
pop up an edit menu or select 

Allocation from the Edit menu. 
 

 

If you have not bought any HASTAM modules you will need to create one using the Editor before you can carry 
out any evaluations.  The Editor is an optional add-on to CHASE which gives you the capability of modifying 
existing questions to suit your requirements, or entering your own modules.  An introduction to the Editor is 
given at the end of this section and it is described more fully in the Help files.  If you are creating a new module or 
ƘŀǾŜ ŀƴ ƻƭŘ ƻƴŜ ȅƻǳ ƴƻ ƭƻƴƎŜǊ ǳǎŜ ŀƴŘ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ƛǘ ǘƻ ŀǇǇŜŀǊ ƻƴ ƻǘƘŜǊ 
CHASE windows, click in the Hidden box. 

Allocations 
If you are going to be carrying out evaluations on a regular basis you can Allocate a module to an area - ie assign 
a set of questions to one of the areas of your organisation you wish to evaluate.  When you set up an allocation 
you also determine the date of the first evaluation and the interval between successive evaluations.  CHASE uses 
this information to show you the state of your evaluations at any one time. 

When CHASE starts it shows, by default, the Allocation Window, which displays this information.   

Click on the Allocations button if it is not already displayed.  An example of this window is shown below. 

The grid shows the current state of your 
evaluations - due, in progress or overdue.  

The module names run across the top. 

The area names run down the left.  

Areas can have sub-areas.  For example, the 
Forfar area has several sub-areas within it.   

Grey cells are unallocated. 

Green cells indicate an evaluation is in 
progress. 

Red cells indicate overdue evaluations. 

White cells show when the next evaluation is 
due. 

The dark blue cell indicates where an 
allocation is no longer set up but previous 
evaluations are still present - no interval is 
shown. 

Brown cells indicate where unscheduled evaluations have been carried out. 

The dates show when the next evaluation is due with the exception of green cells (evaluations started but not 
completed), which show the date of the evaluation that is in progress and the dark blue cells (allocation has been 
deleted) where the date is that of the last evaluation.  Intervals are in units of days, weeks months or years.  

Module Area 
Allocation 
Due date 
Interval 
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άbƻƴŜέ ƛƴŘƛŎŀǘŜǎ ǘƘŀǘ ƴƻ ƛƴǘŜǊǾŀƭ Ƙŀǎ ōŜŜƴ ǎŜǘ ǳǇ - in these cases, once the evaluation has been completed, no 
further ones will be scheduled. 

If you have areas and modules but the cells are all empty, you need to allocate 
the modules to the areas.  To do this double click with the mouse in the 
appropriate cell for the required area and module.  A dialogue box opens 
allowing you to enter the interval between evaluations (eg 6 months, 2 years) 
and the date the first evaluation is due.  Once the allocations are set up you 
can move on to answering an evaluation. 

Answering an Evaluation 
The main data input task is to answer the questions contained in the module, following, where necessary, the 
guidance given.  However, there are two optional additional input facilities available for each question. 

Notes.  You may wish to make notes about your answers, for example recording details of why it was not possible 
ǘƻ ŀƴǎǿŜǊ ά¸ŜǎέΦ 

Recommendations.  You may wish to record, or recommend, remedial action.  In this case you should make a 
recommendation.  These differ from notes in that they include priorities and dates and CHASE keeps track of 
them, for example, enabling you to print a list of recommendations which have not yet been actioned. 

Unscheduled Evaluations 

To start an unscheduled evaluation, click on the Start unscheduled evaluation button ( ) or select New 
Unscheduled Evaluation from the File menu. 

This displays the New Evaluation dialogue box which allows 
you to select the module and area you wish to use.  
Depending on where you are in CHASE, the module and/or 
area may already be selected - for example, if you are in the 
Modules window, the currently selected module will be 
selected in this box already.  You can change either or both if 
you wish. 

Next enter the evaluation date.  This will default to today but 
you can edit this or click on the arrow on the right of the 
date to pop up a calendar. 

The category will initially be the default category for the 
module but you can change this to any of the other 
categories.  NB: Once you click on the OK button it is not 
possible to change the category. 

You should also select the reason for the evaluation. 

Below this you can record the names, roles and status for people involved in the evaluation.  Click on Add to add 
a person.   

You can type in the name or select from the list.  The list is 
automatically generated from the names you enter so it 
will grow with time.  Once you have entered a name you 
can select a role and status. 

LŦ ȅƻǳ ƴŜŜŘ ǘƻ ŎƘŀƴƎŜ ŀ ǇŜǊǎƻƴΩǎ ŜƴǘǊȅ ǳǎŜ ǘƘŜ Edit  button 
to alter it or use the Delete button to remove it.  You can 

include as many people as you like.  Note that roles available depend on the category and, 
if you change the category after entering names of people, their roles may be invalid. 

Finally you can record any other administrative details in the Details field. 

This data can be revised after the evaluation has been started by going to the Administrative Details option in an 
evaluation - see later. 

Click on OK to create the evaluation record and begin answering the questions. 
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Scheduled Evaluations 

To start a scheduled evaluation either  

1. double click on an allocated 
cell in the Allocation 
Window, or  

2. click on the Evaluations 

button on the toolbar to 
open the Evaluations 
Window to show a list of 
evaluations in progress, 
due, and overdue, as 
shown here on the right.  
The Display by options on the 
menu allows you to list By 

area or By module.  The Include 
settings determine which 
types of evaluation are 
displayed.  Double click the required evaluation to open it. 

If the evaluation is being opened for the first time you will be 
asked complete the evaluation details. 

This is very similar to the details for unscheduled evaluations 
except that 

1.  The module and area cannot be changed as they have 
been set by the allocation.  The schedule information is 
shown (ie the due date and the interval between successive 
evaluations.) 

2.  The reason is set to Scheduled. 

3.  There is an option to base this evaluation on a previous 
one (not available for the first scheduled evaluation).  If this 
is done, the answers, notes and tags (if used) from the 
previous evaluation can be copied into the new one. 

The remainder of the fields are the same as for unscheduled 
evaluations. 

Answering an Evaluation 

The screen below shows a typical question.  The left side of the evaluation question window shows the position in 
the evaluation, the right displays 
the question.   

Use the mouse to select the appropriate 
answer or N/A if Not Applicable (where 
permitted) 

Click on the right pointing button to move 
on to the next question. 

Use these buttons to go back, make 
general notes or edit the administrative 
details. 

.Click in the left-hand panel to go directly 
to different sections and questions in the 
evaluation. 

The bottom part of the question panel 
shows guidance, notes, 
recommendations or tags, depending on 
which of the ñtabsò has been selected. 
This example is showing guidance. 

(V = Verification). 

As you work through the 

Uncompleted Due Overdue Completed 
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questions the left-hand panes will be updated to show you your position in the evaluation.  You can also click 
with the mouse in either of the two left panes to navigate quickly around the evaluation.  For example, click on 
the module name to show a list of all the sections within the module in the lower left pane, or click on a question 
in the lower left to go to that question.  The question icon shows the status of the question.  A  shows an 
unanswered question, a  shows an answered question and  is a verified question.   

Question answers may be Yes/No, percentage or marks or there may be a list of alternatives for you to choose 
from.  In addition you may be able to answer N/A for Not Applicable, in which case the answer is ignored for 
scoring purposes.  The Verify button is for situations when line managers answer the questions themselves and 
these answers are subsequently verified by an external auditor.  Not all users will see this button. 

You can make use of the guidance if the question itself is not clear and you should make notes and comments as 
these can be useful when carrying out a re-evaluation later or when you have to justify your answer, to an 
auditor for example. 

If an answer is No you may want to create a recommendation.  This is an 
action that needs to be carried out so that the question can be answered 
Yes, or given a higher mark, in a later evaluation.  The Recom... tab shows 
you any recommendations already made for this question and provides 
you with the facility to add new ones.  An example of a recommendation 
is shown here.  You may have more than one recommendation per 
question if necessary.  Recommendations are dated and can be assigned 
to the person who is to be responsible for ensuring they are carried out.  
Recommendations are accessible from outside the evaluation through 
the Recommendations Window (see later) and can be used to create 
action plans. 

The answers, notes, etc, are saved automatically as you progress. 

Completing an Evaluation 

When all the questions have been answered, you should go into the Tools menu of the evaluation window and 
select Complete evaluation.  This marks the evaluation as complete, any unanswered questions are given a zero score 
and the allocation table will show when the next evaluation in the sequence is due.  Depending on the rights of 
your User name, you may also be prevented from making further changes to the answers; therefore do not 
complete an evaluation until you are sure you have entered all the data.  For scheduled evaluations you must, 
however, complete an evaluation before you can start the next one in the sequence for the selected area and 
module. 

Analysing the Scores 
/ƭƛŎƪ ǘƘŜ ά!ƴŀƭȅǎƛǎέ ōǳǘǘƻƴ  or select Analysis from the View menu to show the score table.   

If you are in an evaluation when you do 
this, the scores for that evaluation will 
be calculated, otherwise the empty table 
as shown below appears. 

If more rows or columns are loaded than 
can be displayed on your screen, use the 
scroll bars or cursor keys to move 
around the table. 

Each column can display an evaluation, 
target or summary and the scores in the 
columns can be summarised in an extra 
column that appears in the extreme 
right of the table.  The number of rows 
and columns that can be displayed at 

one time depends on the resolution of your computer display. 

Load 
columns 

Unload 
column 

Graphs 
button 

Summary data will 
appear here 

Summary 
functions 
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Click on the Load columns button  to bring up the load evaluations dialogue shown on the next page.  This will 
allow you to select those evaluations you want to analyse from those present in the CHASE database.  You can 
load evaluations, summaries and targets from several areas and even different modules, allowing you to perform 
a wide range of comparisons - ŜƎ ƻƴŜ ŀǊŜŀΩǎ ǇŜǊŦƻǊƳŀƴŎŜ ƻǾŜǊ ŀ ƴǳƳōŜǊ ƻǊ ȅŜŀǊǎΣ ŀ ŎƻƳǇŀǊƛǎƻƴ ƻŦ several areas 
ǿƘŜǊŜ ǘƘŜ ǎŀƳŜ ƳƻŘǳƭŜ Ƙŀǎ ōŜŜƴ ǳǎŜŘΣ ƻǊ ŜǾŜƴ ƻƴŜ ŀǊŜŀΩǎ ǇŜǊŦƻǊƳŀƴŎŜ ƛƴ ŀ ƴǳƳōŜǊ ƻŦ ŘƛŦŦŜǊŜƴǘ ƳƻŘǳƭŜǎΦ 

Click here to list modules or areas.  This 
example shows areas. 

Next highlight an area (or module if 

By Module is selected). 

 

Then select the required Uncompleted ( ), 

Completed ( ), Target ( ) or Summary 

( ) evaluations and click on Add to add 

them to the list to pass back to the analysis 
table. 

Add All copies all evaluations in the top right 
window to the bottom one. 

The Remove and Remove All buttons are 
used to remove evaluations that have been 
selected in error from this list.   
 

Click OK to complete. 
 

The table is then loaded with the scores from the selected evaluations - this can take several seconds as CHASE 
calculates the scores for the questions.  A part of a loaded table is shown below. 

 

 

 

The scores can be shown as actual marks or as percentages by selecting the appropriate Display Options (top 
left).  You can show original (Normal) scores or Verified scores - right-click on a column to pop up the column 
menu or select Scores from the Options menu.  Sections of the module can be collapsed or expanded by clicking on 
the  and  symbols.  You can expand or contract individual sections or use the buttons below the list to 
expand or contract all sections to the same level.  If evaluations based on different modules are loaded, the 
section headings displayed will be those of the highlighted column - this is the one with the heavy border round 
it.  Comparing scores from different modules must be done with care. 

The table can be printed out in a number of ways.  Use File|Print options to determine what is printed and how.  You 
can also copy the data to a spreadsheet.  The simplest way is to click on the Copy button on the toolbar, switch to 

 

Display options. Scores  
can be shown as marks or 

percentages and the maxima for 
each section can be displayed if 

required. 

Module structure.  Sections 
can be expanded or 

collapsed as required.   

Column header 
showing date, status 
area and module. 

Maximum score 
column. 

Actual score column.  
Shows percentage in 
percent modes. 

Other column data - 
right click to change 
values. 

Column selectors for graphs 
and printing. 

Row selectors for graphs 
and printing. 

Highlighted column. 
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your spreadsheet program and select Paste from its toolbar or edit menu.  There is also a File|Save asé option to 
save the data in a file for use in other programs. 

If you frequently reload the same set of evaluations, you can save the list of evaluations for later recall.  Use the 
File|Save column list option to save a list of loaded evaluations in a file for later recall. 

Several evaluations based on the same module can be combined into a summary.  Click on the summary button  
to show this.  The summary data is always displayed in the right hand column of the table.  If the summary button 

is greyed out, the evaluations loaded are not 
compatible and cannot be summarised. 

To show a graph, select a number of rows and 
columns (click in the boxes by each row name and on 
the selection buttons at the bottom of each column). 
Then click on the Graphs button  to pass this data to 
a separate program, called Graphics Server, which 
displays the graph.  This has a number of options for 
displaying bar charts, lines graphs, 3D charts, etc.  An 
example is shown here. 

Click on the Print button to print the graph. 

Click on Copy to copy the graph data to other 
programs using the Clipboard. Use the Labels button to 
edit the labels before printing or copying. 

Reports 

From Version 2.0.0 CHASE incorporates Crystal Reportsá to provide 
improved output from CHASE.  These are generated from the Analysis 

Window by clicking on the Reports button .  The report is generated 
for the highlighted column (which has a border round it).  After few 
seconds while the data is processed, the Report dialog appears. 

This dialog allows you to select the required report in the top field, set 
up standard text items to appear on the front page of the report and 
alter some other features of the report as shown here.  These can be 
made the default settings for future reports by clicking on Make 
default. 

Once all is set, click on Generate to produce the report in a new 

window. 

Reports can be printed or exported to a 
range of other applications such as 
Microsoft Word or Adobe Acrobat.  
There is no facility in CHASE to alter the 
format of a report.  If you wish to do this 
you will require a full copy of Crystal 
Reports, available from most software 
suppliers.  As this is a third party product, 
HASTAM cannot provide user or 
technical support for it.  We can also 
design reports for you ς contact us for 

details and fees. 

Recommendations 
When answering an evaluation you can make recommendations (see page 11). The Recommendations Window 
provides access to these from outside the evaluations.  This allows you to keep track of them without having to 
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go back into individual evaluations to find them.  It makes it easy to look at the recommendations for a number of 
areas or modules simultaneously, enabling you to keep track of the progress individual managers are making 
towards carrying out their recommendations.  Click on the Recommendations button  to open the 

Recommendations Window. 

When this window opens you first need to click on one of the three buttons in the 
top left corner.  All Due displays all recommendations due on or before the Until date.  

Any due before the Due date will be flagged as overdue with a warning symbol.  Find lets you refine the search - to 
limit the list to one area or module perhaps.  The Dates button allows you to change the date range used by the 
search. 

Area, Module and Question that prompted the 
recommendation. 

Date by which recommendation should be 
carried out. 

 

Date recommendation completed. 

 

Priority (1 - 99). 

Name or initials of person setting up the 
recommendations. 

 

Person responsible for ensuring the 
recommendation is carried out. 

 

The text of the recommendation. 

 

 

The headings of the list columns can be changed to other fields if you prefer - right-click and select Headingsé or 
select the Tools|Change headings from the menu.  

You can use the Find  button to refine your searches - 
for example to find recommendations due in one 
particular area or for one person.  The Find dialogue 
ƛƴƛǘƛŀƭƭȅ ǎƘƻǿǎ ǘƘŜ ά/ƻƳǇƭŜǘŜŘ ƻƴ ƛǎ ōƭŀƴƪέ ŜƴǘǊȅΦ  
Click on the And or Or buttons to add other conditions 
as shown in the example here.  

You can update the recommendations that are shown in this window.  Typically, you will need to fill in the 
Completed on date when a recommendation has been carried out, which will stop it appearing in future.  You can 
still access completed recommendations, either through the original evaluations, or by using the Find button 
above to search for recommendations that have been completed - ie set the Completed on condition to one that is 
not blank. 

Printing 
Printing, through the toolbar or the File menu, is 
available for most of the windows.  For each one you will 
find, under the File menu, a Print options item allowing you 
to select what you want to print out, how you want to 
set up your page margins and to select the fonts you 
want to use on your printout.  An example is shown 
here. 

When printing an evaluation or module, the printout is 
for the currently highlighted section.  This gives you the 
option of either printing the whole module/evaluation 
or just the selected section.  In anŀƭȅǎƛǎΣ ǘƘŜ ǿƘƻƭŜ ǘŀōƭŜ ƛǎ ǇǊƛƴǘŜŘ ǳƴƭŜǎǎ ȅƻǳ ƘŀǾŜ ŎƘŜŎƪŜŘ ǘƘŜ άǎŜƭŜŎǘŜŘ ƻƴƭȅέ 
option in the print options, in which case the graph selections also apply to printing. 

List of outstanding recommendations.  Can be sorted by Priority, Due date or Action by 
fields. (Click on the appropriate heading.). Scope allows you to limit list to a group of areas. 
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Before printing, we recommend you use the Print preview option to check on-screen what is going to be printed.  
This is especially true when printing evaluations and modules where there are a large number of print options 
and it is easy to inadvertently miss an item on one of the set-up options screens.  In a module of several hundred 
questions this could result in many wasted sheets of paper. 

If you want more sophisticated printouts, use the File|Save asé option to save the evaluation or module as a text 
file and then word process it.  Alternatively, use the Reporting function of the Analysis table where a number of 
different reports are available. 

Setting up Other Users (Administrators of 
multi-user systems only) 
Click on the Users button  to show the Users 
Window.  Select File|New User to add other users to 
the program.  Each user can be assigned specific 
rights within CHASE.  CHASE is available as a 
multi-user system and can be run on a network.  
Each user name keeps a record of the settings in 
the program so two different users can 
independently configure such items as Print 
options, Analysis options etc.  Users can also be 
assigned to specific areas and/or modules.  The 
example here shows a user called Fred who can 
allocate, answer questions and analyse the scores for a limited number of areas and modules, as shown by the 
checked boxes. 

Editing and Creating Modules (Optional Module Editor Function) 
The usefulness of CHASE depends largely on the effectiveness of the questions and guidance contained in the 
modules.  If these do not reflect accurately what is required, the monitoring and audit results obtained will be of 
limited value.  Therefore, it is important to put thought and care into setting up modules.   

If you have purchased the Editor you are able to alter existing modules and create your own.  It enables you to 
tailor the questions so that they match your own policies and procedures much more closely than if you use a 
/I!{9 ƳƻŘǳƭŜ άƻŦŦ ǘƘŜ ǎƘŜƭŦέΦ  ¸ƻǳ Ŏŀƴ ŜŘƛǘ ǘƘŜ ǉǳŜǎǘƛƻƴǎΣ ŀŘŘ ƻǊ ǊŜƳƻǾŜ ǘƘŜƳΣ ƻǊ ǊŜǎǘǊǳŎǘǳǊŜ ǘƘŜ ƳƻŘǳƭŜ 
altogether. 

To edit a module, open the Modules window (select View|Modules or click on the modules button ), highlight the 
module you want to edit and either select File|Open module or double-click the module name.   

You can also create your own modules by selecting File|New module.  The CHASE SMi 18001 module is shown below 
opened in the Editor. 

The left panel shows the moduleôs structure 
while the right shows the content of the 
selected item in the structure. 

Sections are indicated by the folder icon ( ) 

and questions by the question mark ( ) icon.  

Questions and sections can be mixed at any 
level. 

Click on the icons to expand a section into 

its subsections.   

Click on the  icons to collapse them again. 

 

Use the mouse to ñdragò sections within the 

left panel.  You can drag items from the right 

panel into the left - eg to move a question to 
another section.  Dragging with a Ctrl key 
pressed copies the item. 

You can also use the clipboard to copy 
items.  Select the item(s) in the right 

panel and then choose Edit|Copy from the menu or, alternatively, right click and use the pop-up menu that 
appears.  You can then select the appropriate item in the left panel and Paste the selected items to it.  This also 
allows you to copy items from one module to another.  Copy also places a text copy in the clipboard to paste into 
other programs. 
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The File menu is where you will find the options to create a New question or New section.  The new item is created in 
the section highlighted in the left window pane.  Eg to create a new main section, click on the module name to 
highlight it, then select New section from the File menu.  To 
create a new question in section 8.1, click on it in the left pane 
(as shown above) and select New question from the File menu.   

Examples of the New Section and New question dialogues, 
which are very similar to each other, are shown here.  
Normally, all you need enter for a section is its name.  You can 
enter guidance for sections or questions.  Section guidance is 
available to all questions in a section.  See over the page for a 
detailed description of a question. 

Sections can be Conditional.  If you select this option, you can 
then enter a Control questionΦ  ¦ǎŜǊ Ƴǳǎǘ ŀƴǎǿŜǊ ά¸Ŝǎέ ǘƻ ǘƘƛǎ 
question before they can answer the questions within it. 

To delete a question, select it in the right pane (questions only 
appear in the right pane) then choose Delete from the Edit menu or press 
the Del key.  You can undelete deleted questions.  In the View menu, 
select Include deleted records to show any questions you have deleted - 
their icons have a red cross over them - and use the Undelete option in 
ǘƘŜ 9Řƛǘ ƳŜƴǳΦ  LŦ ȅƻǳ ŘŜƭŜǘŜ ŀ άŘŜƭŜǘŜŘέ ǉǳŜǎǘƛƻƴ ƛǘ ƛǎ ǊŜƳƻǾŜŘ 
permanently.   

You delete an entire section by selecting it in the left or right pane and deleting in the same manner as a 
question. 

To edit a question, double-click its entry in the right panel or highlight it and select Open question from the File 
menu.  The question edit dialogue box pops up allowinƎ ȅƻǳ ǘƻ ƳƻŘƛŦȅ ǘƘŜ ǉǳŜǎǘƛƻƴΩǎ ǘŜȄǘΣ ǿŜƛƎƘǘƛƴƎΣ ǘȅǇŜΣ 
guidance etc. 

The question number - edit to change the position of a question within a 
section.  Values of 0-999, A-Z and a-z are permitted. 

The weighting - the number of marks assigned to the question in the 
range 0 to 250. 

The question text. 

 

The answer type - choose from the list (Yes/No, Marks, Percentage, 

No/Yes) or click New to create your own multiple-choice answers to go 
in this list. 

If ticked, allows user to answer Not Applicable. 

You can set a default answer if you wish 

Space for guidance, notes, default recommendations and tags.  
Guidance is of two types - normal guidance for everyone and verification 
guidance for those users who can verify answers.  Default 
recommendations are standard actions that can be carried out if the 
answer is unsatisfactory.  Tags allow you to group together related 
questions (eg training questions). 

Click on OK to save the question. 

 

There are options in the File menu to create new questions or sections, or open a section to edit its name or 
number.  Sections can be Conditional, where users must answer Yes to a Control question before they can 
answer the questions in the section.  You edit a section in a window very similar to that for editing a question.  

The data is saved automatically to disk as you work - there is no need to explicitly save anything. 

Once you have completed a module you can then allocate it to areas so that the questions can be answered.  If 
you need to copy the module to other CHASE users, use the File|Export option to create a file you can send to other 
people.  They can then use the File|Import function to incorporate it into their own copy of CHASE. 
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Creating Single Evaluation Files (Optional add-on) 

If managers etc answer their own evaluations and do not have access to the CHASE program, you can print out 
the answers on paper for them to complete.  However, you can alternatively create file copies of evaluations that 
can be completed on other computers and returned later. 

The evaluation must be started on your main CHASE system first.  Start this in 
manner described earlier and then, from the File menu of the Evaluations 
window, ŎƘƻƻǎŜ ǘƘŜ άCreate a Single Evaluation Fileέ ƻǇǘƛƻƴΦ  ¢Ƙƛǎ ǿƛƭƭ ŀƭƭƻǿ ȅƻǳ ǘƻ 
save this evaluation in a named file in any location accessible to CHASE. 

Send this file, with the Answer program disk (see below), to the person who is 
to complete the evaluation. 

Uploading a single evaluation file 
When the evaluation has been completed, the file is returned to you and, using the òFile|Upload a Single Evaluation 
Fileέ ƻǇǘƛƻƴ ƛƴ ǘƘŜ 9Ǿŀƭǳŀǘƛƻƴǎ ²ƛƴŘƻǿΣ ǊŜƭƻŀŘ ƛǘ ƛƴǘƻ ȅƻǳǊ ǎȅǎǘŜƳΦ  ¢ƘŜ ƻǊƛƎƛƴŀƭ ŜǾŀƭǳŀǘƛƻƴ ǿƛƭƭ ǘƘŜƴ ōŜ ǳǇŘŀǘŜŘ 
with the answers in the file.  Single evaluation files can only be uploaded onto the system that created them. 

The Answer program 
Single evaluations are answered using the Answer program.  Users completing a single evaluation must install this 
program on their computer first, therefore when sending the first file to be completed, instructions for installing 
this must be sent as well.  The Answer program does not support verification or tags; print options are more 
limited, only one evaluation at a time can be answered and there is no analysis.  The Answer program setup disk 
can be freely copied or it can be downloaded from www.hastam.co.uk.  Full details of this program are in a 
separate document. 

Using a PDA (Optional Add-on) 

A CHASE evaluation can be answered on a Windows based PDA and then uploaded into CHASE for analysis.  This 
requires Microsoft ActiveSync for Windows XP or Windows Mobile Device Center for Windows Vista to manage 
the communication between CHASE and the PDA.  Full details are in a separate document. 

Other Useful CHASE Functions 

Tools 

The Tools menu provides a number of other useful functions - use the F1 key or Help for more details.  The items 
in the menu will depend on which CHASE window is active and include the Change Password and Customise 
functions. 

Data transfer 

The File menu also has a number of utility functions within it - for example Export and Import allow you to transfer 
records from one CHASE system to another.  Warning: when transferring records between systems, errors will 
occur if the two programs have been installed from the same set of disks or CD-ROM.  Each copy of CHASE is 
individually assigned a serial number that is used to identify the records.  If you have bought two or more copies 
of CHASE you must initialise each copy with its own serial number and never use the same serial number more 
than once. 

Tags 

CHASE modules are usually broken down into sections of related questions.  You can also isolate groups of 
questions using the Tag ŦŀŎƛƭƛǘȅΦ  ¢Ƙƛǎ ŀƭƭƻǿǎ ȅƻǳ ǘƻ ǇƭŀŎŜ ǉǳŜǎǘƛƻƴǎ ƛƴǘƻ ŎŀǘŜƎƻǊƛŜǎ ǎǳŎƘ ŀǎ ά[ŜƎƛǎƭŀǘƛƻƴέ ŀƴŘ 
subsequently isolate these questions to answer or score them independently.  Tags are usually set up in a module 
using the editor.  Users can then use them when answering an evaluation or looking at their scores in Analysis.  
Help provides details on using tags. 

Exiting CHASE 
Close CHASE as you would any other Windows program.  You can: select Exit from the File menu, click on the 

 button in the top right of the main CHASE window or press Alt/F4 on the keyboard.  Any data in edit windows, 
eg Notes, will be saved automatically - there is no need to close them first.  If the Analysis table is open with data 
in you will be asked to confirm you want to close it - this is in case you have just spent five minutes loading fifty or 
so evaluations and then clicked the close button by mistake.  If you prefer to confirm you want to exit the 
program in all circumstances, set Confirm exit program in Tools|Customise. 

http://www.hastam.co.uk/
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Section 4  Other Information 

Technical Information 
CHASE is written in Microsoft Visual C++ and the executable file is CHASE.EXE.  The data is stored in a Microsoft 
Access database file (CHASE.MDB) and the security provided by the Microsoft Access workgroup file 
(CHASE.MDW).  The CHASE.MDB file also holds the licence information and serial number for the system.  
Microsoft Access is not required as the CHASE program provides all the database functions through the Microsoft 
JET engine and Data Access Objects. 

Other application files are the help files (CHASE.HLP, CHASE.CNT, CHASE.GID and possibly other, user-created 
files), a configuration file (CHASE.CFG created when CHASE is run for the first time), an export-database template 
(CHASE.BDB). 

Graphics are provided by the Graphics Server® program from Graphics Server Technologies and the appropriate 
run-time files (GSW32.EXE and others) are installed in the Windows\System directory.  Various other DLLs (eg 
MFC40.DLL, MSVCRT40.DLL, etc) will also be installed in the Windows\System directory if they are not already 
there.  If they are not already present (eg in Windows 9x versions or NT4), the Microsoft Data Access 
Components (MDAC v2.6) are installed to provide database functionality.  Reporting is provided by the Crystal 
Reports OCX Control (v8.5).  Spell checking is provided by the Polar Spelling Check component. 

If you need to know exactly which files are installed, they are listed in TechInfo.doc on the CD-ROM.  There are no 
licensing implications with any of these ancillary files. 

The CHASE Serial Number 
This number is entered when CHASE is run for the first time and is used to initialise the CHASE database file 
(CHASE.MDB).  The serial number is used to identify CHASE records (see the TechInfo document on the CD-ROM 
for details) and it is vital that no two copies of the database have the same serial number otherwise data cannot 
be moved between them without overwriting data.  If additional copies of CHASE are installed on other 
workstations that connect to the same database (see Networking below), it will not be necessary to enter serial 
numbers when these are run for the first time as the database is already initialised.  If you are asked for one, it 
almost certainly means that the database location was incorrectly entered when the additional copy of CHASE 
was installed. 

There have been occasions when an organisation has legitimately purchased several copies of CHASE but the 
installer has assumed that any valid serial number is OK to initialise the program.  This is not the case for CHASE 
and each copy MUST be initialised using its own, unique, serial number. 

See below about moving CHASE from one computer to another, which also has serial number implications. 

Moving CHASE from one Computer to Another 
If you wish to move CHASE from one computer to another it is vital that the three CHASE data files are copied 
first.  Copy the CHASE.MDB, CHASE.MDW and CHASE.CFG files to a safe place.  These files are normally located in 
My Documents\CHASEDatabase\ by the setup program, but can be elsewhere.  For simplicity you may wish to copy the 
entire CHASEDatabase folder.  This will also copy personal dictionaries, modified report templates, etc. Copy 
these files to a network drive, CD-ROM or other backup medium.  Now install CHASE on the new computer and 
use a Custom install.  Do not install the data files and do not run CHASE.   

Now copy the three data files (or the entire CHASEDatabase folder) from the old computer to the database 
directory selected during installation.   

If these steps are carried out correctly, you are not asked for a serial number when CHASE is started on the new 
computer.  If you have made changes to report files using Crystal Reports, copy these files also. 

You must not use the export function to backup data, install CHASE on another computer as a new system (ie 
entering the serial number) and then import the backed up files.  This will not work correctly as the record 
counters will be set back to zero and duplicated records will be created, generating errors and probably 
corrupting data. 

Networking 
CHASE may be installed on a local area network without incurring additional charges from HASTAM.  The number 
of concurrent users will have been set to 1, 5 or 10 at the time of purchase.  There are two installation 
configurations. 



Page 20 CHASE 

Copyright © 2011 Health and Safety Technology and Management Ltd 

  
  

1. (Recommended) Install the application and system files on the workstation and install the database files in a 
server directory - this is an option in the Install procedure.  The command line of the Windows short cut used 
to start CHASE will be modified by the installer program to 

[program path]CHASE.EXE  [directory path]  

where [directory path] is the location of the CHASE.MDB, CHASE.MDW and CHASE.CFG files.  For example, if 
the data files are on drive H in a folder called AUDIT, the command line would be 

òC:\Program files\HASTAM\CHASE\Chase.exeó  H:\AUDIT 

or òC:\Program files\HASTAM\CHASE\Chase.exeó  \\ServerName\SharedDriveName\AUDIT 

Alternately, if the directory path parameter is not included, the user will be asked to browse for the 
CHASE.MDB file when CHASE is started.  Once found, this will be stored in the CHASE initialisation 
information. 

A /N switch can be placed at the end of the command line to tell CHASE not to offer to browse for the file but 
simply report that it could not  be found.  This can be useful for example on a laptop that may or may not be 
connected to the network.  If the network connection is absent the user will simply be told that the database 
cannot be found and not given the opportunity to look for a non-existent file.  The example above would 
become 

 òC:\Program files\HASTAM\CHASE\Chase.exeó  \\ServerName\SharedDriveName\AUDIT /N 

The database folder holds the data files (CHASE.MDB and CHASE.MDW, the configuration file (CHASE.CFG) 
and the report files (ReportTemplate01.mdb and the Reports folder). 

2. Install the application and database files on the server in one directory and run CHASE from there.  Other 
workstations using the application will require the Windows System files to be installed in their 
Windows\System directories.  Use the Custom Install option to install these on the workstations. 

The second option imposes a higher demand on the network as it has to handle data traffic and the application 
itself and is not recommended. 

You may install the application and system files on more than one workstation, provided there is only one copy 
of the CHASE.MDB data file on the network. 

Hardware Requirements 

Operating system Windows 98, Me, 2000, XP, Vista, 7 or NT4.0 (Service Pack 6) - PDA option 
requires Windows 2000 or later 

CPU 300+MHz Pentium recommended 

RAM Minimum recommended for version of Windows in use 

Disk space Approx 65MB for application and system files.  Typically 2 to 50MB for the data 
files. 

Display SVGA or higher recommended 

 

Technical Support 
HASTAM provides telephone support for CHASE Monday to Friday, 9am to 5pm, UK time.  The telephone number 
is 0844 561 0434. 

Alternatively you can send an e-mail to: support@hastam.co.uk.  We also have a website 
(http://www.hastam.co.uk) which has a support page on it. 

Full details are to be found at the front of this user guide. 

Context-sensitive Help is available by pressing the F1 key and structured guidance is found 

through the Help menu.  Do make use of this facility - there are over 400 pages available. 

file://ServerName/SharedDriveName/AUDIT

